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Introduction to the Guide 

The Technological University of the Shannon: Midlands Midwest (hereafter referred to 

as TUS or the University) values and promotes inclusiveness, equity of opportunity 

and respect for all students and staff. TUS aims to provide opportunities for all students 

and staff to thrive in higher education and in the wider community through the 

promotion of positive identities and abilities, the celebration of diversity and difference, 

and the provision of an inclusive, participative culture and environment.  

 

The TUS Strategic Plan 2023 – 2026[1] specifies Inclusive as a core Value and 

identifies a value statement that “we embrace diversity as a key strength where 

everyone is included and has an equal opportunity to progress and achieve”. 

Accordingly, TUS commits to provide leadership in promoting and advancing equality, 

diversity and inclusivity and is committed to supporting an environment that is inclusive 

and accessible to all”.[1] TUS is increasingly diverse and it is vital that the members of 

its community including all internal and external stakeholders are supported through 

accessible communication modes. TUS is cognisant of its obligations under The Equal 

Status Acts 2000-2015[2], as amended which prohibits discrimination on the provision 

of goods and services, accommodation and education. The Disability Act 2005[3] 

identifies the requirement to provide information in an accessible format. Additionally, 

the Altitude Charter,[4]  adopted by TUS in 2025 as a university-wide commitment to 

advancing inclusive practice and ensuring equitable access, participation, and 

success for all students. 

 

The TUS Dignity & Respect at Work Policy & Procedures[5] is a key reference point for 

TUS staff and state that TUS “is committed to creating a positive culture which 

recognises and reflects the dignity of each member of the TU community, through the 

promotion of good and professional behaviour and attitudes, embracing diversity, 

encouraging each person to reach their potential, and fostering social inclusion and 

equality.” Additionally, the TUS Student Communications Commitment Statement[6] 

notes that TUS strives to “ensure that our communications reflect the diverse 

identities, cultures, and experiences within our student body, promoting a sense of 

belonging for all.” 

The development of this TUS Guide to Promoting Inclusive and Professional Written 

Communication is consistent with the EU Accessibility Directive[7] requiring public 

bodies to ensure inclusive and accessible communication. The Guide is available as 

a practical resource for staff, designed to support and encourage engagement with 

equity, diversity, and inclusion principles in everyday professional practice. It is 

intended as a helpful reference, not a prescriptive policy, empowering staff to 
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communicate in writing more effectively, foster inclusivity, and maintain 

professionalism in written interactions.  

The Guide aims to enhance confidence and consistency across written 

communications while allowing individuals the flexibility to adapt recommendations to 

their particular contexts. Accordingly, this Guide is divided into three parts as follows:  

1) Part A: TUS Guide to Using Gender Neutral Terminology; 

2) Part B: TUS Guide to Written Communication Etiquette; 

3) Part C: TUS Guide to Accessible and Inclusive Document Design. 

 

Part A supports inclusive practice by providing examples of gender-neutral 

words/phrases that may assist in making gender-neutral documents or other 

communications. 

 

Part B outlines key considerations for written communication etiquette and identifies a 

range of considerations that support professional practice when composing written 

communications, including on paper, email, MS Team or any other electronic 

correspondence applications. 

 

Part C provides a guide to creating accessible and inclusive documents and provides 

recommendations for incorporating clear layout and structure and utilising accessibility 

features that support the effective use of the resulting documentation by all readers. 

 

B. Overarching Principles Underpinning the Guide  

The overarching principles that underpin this guide include: 

1) promoting written communication that respects and values the diversity of the 

TUS community,  

2) fostering a culture where all individuals feel included and supported;  

3) maintaining a professional tone that reflects the dignity and respect due to all 

members of the University community, fostering positive, respectful, and 

inclusive communication; 

4) promoting practice that aims to make written communications clear, readable, 

and designed in formats that are accessible to all users.  
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1.0 Purpose of the Guide  

This guide is produced in the context of TUS’s commitment to guiding and supporting 

gender-neutral communication. In line with the TUS core Value of Inclusive, this guide 

offers examples of gender-neutral terms for use in TUS official documentation as well 

as for staff who are seeking additional guidance and support in using inclusive 

language. 

  

2.0   Scope of the Guide  

This guide contains a list of suggested gender-neutral words/phrases that may assist 

in making gender-neutral documents or other communications. The guidance applies 

to all forms of communication within TUS, including policies, reports, emails, 

webpages, and promotional materials inter alia. By taking account of the guide, staff 

can contribute to making communications that are inclusive and reflective of the 

diversity of the TUS community. 

 

3.0   Using Gender-Neutral and Inclusive Language 

Gender-neutral wording decisions may be straightforward, and a neutral term can be 

selected in lieu of a gendered term. In more complex cases, it can help to rethink the 

order of the sentence, to search alternative terms, or to consider whether the 

phrase/sentence is necessary at all. Moving beyond gendered terms can make a 

document more reflective of the diversity of families and relationships in Ireland.  

Gender-neutral language also allows for open interpretation of social roles, for 

example, the term “fire fighter” denotes someone of any gender, unlike the term 

“fireman”.  

 

Producing documents that are gender-neutral or updating existing documents to make 

them gender-neutral, demonstrates acknowledgement and inclusion of transgender 

members of our community (students, staff or visitors). Many people do not identify as 

either male or female and references to “he”, “she” or “he/she” are therefore often not 

adequate to describe all the people to whom a document applies1. Finally, it is not 

necessary to include gender distinctions in most documents (many languages get by 

without them) and removing them can make documents more concise.  

 

A range of suggested neutral words/phrases are provided in Table 1. 

  

 
1 This doesn’t mean that all transgender people like to be referred to as “they” – but “they” 
covers all genders in a document which will be read by a wide variety of people 
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Table 1. Suggested Gender Neutral Word/Phrase 

Gendered word/phrase Suggested Gender Neutral Word/Phrase 

“He”, “She” or “He / She” They 

“His”, “Her” or “His / Her” Their 

“Him”, “Her” or “Him / Her” Them 

“Mr”, “Ms” or “Mr / Ms” Avoid using these gendered titles unless they are 

necessary. If they are necessary, such as on some 

forms, it is good practice to offer “Mx” as an option as 

well as “Mr” and “Ms”, “Mx” is a title that can be used 

by a person of non-binary gender or by anybody who 

prefers not to disclose their gender. 

“Father” / “Mother” Parent (Similarly, “Grandparent”) 

“Husband” / “Wife” Spouse 

“Boyfriend” / “Girlfriend” Partner 

“Son” / “Daughter” Child 

“Man” / “Woman” Person (or occasionally “human” can be more 

appropriate, e.g. “humankind”). 

“Chairman” / 

“Chairwoman” 

Chairperson (or “Chair”) 

“Dear Sir / Madam” This could be replaced with “To Whom it May 

Concern”, “Dear Colleague”, “Dear Student”.  

“Ladies and Gentlemen” “Honoured Guests”, “Esteemed Colleagues”, inter 

alia. 

Gendered job titles e.g. 

“Barman” / “Barmaid” 

Look up neutral alternatives e.g. “Bartender”. 

“Male” or “Female” as 

adjective 

Don’t use if not necessary to do so: for example, the 

adjective in phrases like “male nurse” or “female 

Professor” is not usually necessary. However, you 

might use these terms where gender is specifically 

relevant, for example, in a report on the number of 

female Lecturers in a department or the composition 
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Gendered word/phrase Suggested Gender Neutral Word/Phrase 

of some university committees (e.g. Academic 

Council Male Female ratio in accordance with TU Act 

(2018). 

“Male” or “Female” on 

forms 

First, consider whether you need to know the gender 

of each person completing the form, and remove the 

gender question if not. If you do need to include a 

gender question, e.g. for statistical purposes, it is 

advisable to include the further options “Non-binary” 

and “Prefer not to disclose”2 . 

Images Try to include diversity of gender in the images you 

use in webpages, posters, etc., and consider how 

you might overcome stereotyping - show a female 

scientist or a male homemaker, for example. 

Symbols (e.g. on toilet 

signs) 

A range of gender-neutral symbols are available and 

the TUS EDI Office can advise on this. 

 

  

 
2 If you report on gender to another body, e.g. the HEA, check their requirements before 
altering your forms 
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1.0 Purpose of the Guide  

The purpose of this guide is to outline key considerations for written communication 

etiquette and to provide clear standards and best practices for writing effectively and 

professionally. For the purposes of this Guide, written communication etiquette refers 

to the professional and appropriate use of language, layout, conventions, and formality 

in written or electronic correspondence applications.  

 

2.0 Scope of the Guide  

This guide identifies a range of considerations when composing written 

communications, including on paper, email, MS Team or any other electronic 

correspondence applications. It outlines key considerations for written communication 

etiquette and identifies a range of considerations that support professional practice. It 

provides guidance on maintaining professionalism, clarity, and courtesy, ensuring that 

written communication reflect the standards and values of TUS. The guide also 

outlines practical tips for structuring written communication effectively, managing tone 

and formality, using appropriate language, and adhering to confidentiality and data 

protection requirements. 

 

This document is a guide that applies to maintaining professionalism, clarity, and 

courtesy in written communication. TUS staff should also be aware of and adhere to 

the requirements set out in related TUS policies which include: 

1) TUS Email Policy 

2) TUS Acceptable Usage Policy 

3) TUS Information Security Policy 

4) TUS IT Systems Access Control Policy 

5) TUS Cybersecurity Incidence Response Policy 

6) TUS Data Protection Policy 

 

3.0 Written Communication Etiquette  

The following aspects may be considered as a guide to professional written 

communication. 

Setting up the Communication 

1) Include a subject heading that is clear, relevant and concise to the context of the 

communication.  

https://tusmm.sharepoint.com/sites/TUSIntranet/IT%20Knowledgebase/Forms/AllItems.aspx?id=%2Fsites%2FTUSIntranet%2FIT%20Knowledgebase%2FIT%20Policies%2FTUS%20E%2DMail%20Policy%2Epdf&parent=%2Fsites%2FTUSIntranet%2FIT%20Knowledgebase%2FIT%20Policies
https://tusmm.sharepoint.com/sites/TUSIntranet/IT%20Knowledgebase/Forms/AllItems.aspx?id=%2Fsites%2FTUSIntranet%2FIT%20Knowledgebase%2FIT%20Policies%2FTUS%20Acceptable%20Usage%20Policy%20v1%2Epdf&parent=%2Fsites%2FTUSIntranet%2FIT%20Knowledgebase%2FIT%20Policies
https://tus.ie/app/uploads/ProfessionalServices/DataProtection/PolicyDocs/CSD.Pol_.TUS-Information-Security-Policy-FINAL-25.03.24.docx.pdf
https://tusmm.sharepoint.com/sites/TUSIntranet/IT%20Knowledgebase/Forms/AllItems.aspx?id=%2Fsites%2FTUSIntranet%2FIT%20Knowledgebase%2FIT%20Policies%2FTUS%20IT%20Systems%20Access%20Policy%2Epdf&parent=%2Fsites%2FTUSIntranet%2FIT%20Knowledgebase%2FIT%20Policies
https://tusmm.sharepoint.com/sites/TUSIntranet/IT%20Knowledgebase/Forms/AllItems.aspx?id=%2Fsites%2FTUSIntranet%2FIT%20Knowledgebase%2FIT%20Policies%2FTUS%20Cybersecurity%20Incident%20Response%20Policy%20v1%2Epdf&parent=%2Fsites%2FTUSIntranet%2FIT%20Knowledgebase%2FIT%20Policies
https://tus.ie/app/uploads/ProfessionalServices/DataProtection/PolicyDocs/DC.Pol_.Data-Protection-FINAL-08.05.23.pdf
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2) In line with accessibility principles, use a sans serif font such as Arial or Sans 

Serif with font size 12. Refer to Part C, TUS Guide to Accessible and Inclusive 

Document Design for further reference with respect to accessibility principles.  

Opening Salutation  

1) Include salutations and address recipients in a professional manner with the 

relevant formal greeting. 

Communication Content 

1) Where possible keep the communication content to that reflected in the subject 

title (in the case of Emails use a separate email for unrelated subjects).  

2) Use Mixed Case Text and avoid where possible the use of Caps Locks, as this 

can be perceived as aggressive or as if someone is shouting. 

3) Use clear language and avoid ‘slang words or phrases’ or emotions in formal 

work-related communication. 

4) Where possible, avoid the use of abbreviations. 

5) Consider using gender neutral pronouns (See Part A, Table 1 of this Guide). 

6) If including attachments or hyper-links, ensure these are noted in the 

communication. 

7) Bear in mind that written communications (including emails and other written 

messages) may be forwarded on to other recipients without your knowledge. 

Avoid sensitive or confidential conversations. 

8) Adhere to confidentiality and data protection requirements at all times in written 

communications. 

Structure of the Written Communication 

1) Begin with a concise introduction stating the reason for your communication and 

outlining any necessary context or background. 

2) Organise information logically and present key points in short paragraphs or 

bullet points, ensuring the message flows in a clear and coherent order. Apply 

spacing, headings, or numbered lists where appropriate to make the content 

easy to read and understand. 

3) End with a clear closing action and summarise required actions or next steps. 

Correspondence Signature and Notices  

1) Include a signature and job role, as applicable. 



13 
 

2) Include relevant contact details so recipients can easily contact you, as 

applicable. 

3) Consider including any logos or branding you deem relevant e.g. TUS, RUN EU 

inter alia.  

4) Consider the use of the Irish/dual language signatures, as appropriate. 
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1.0  Purpose of the Guide  

This  TUS Guide to Accessible and Inclusive Document Design provides 

recommendations for developing formal documents created using MS Word that 

incorporate clear layout and structure and utilise accessibility features that support the 

effective use of the resulting documentation by all readers. The Guide outlines how 

accessibility features may be utilised to generate documentation that allows for content 

to be presented in a professional, accessible and consistent manner.  

 

2.0 Scope of the Guide  

This Guide shall serve as an approved reference point and guidance for TUS Staff 

and assist in producing University documentation using MS Office, including Policies 

and Reports inter alia, that take account of accessibility principles and support 

inclusivity. The constituent documents of the TUS Quality Assurance Handbook shall 

be formatted in a manner that takes account of best practices relating to the 

accessibility principles outlined in this document and utilise gender neutral 

terminology.  

 

The guide is designed to support staff when writing University documentation on the 

recommended layout, structure, and style to ensure a consistent approach across the 

University. The guide covers the following accessibility features: 

• Headings 

• Typeface and Font   

• Bullet points  

• Colour contrast 

• Alternative text 

• Table of Contents   

• Hyperlinks  

• Forms 

• Visual displays diagrams etc 

• Accessibility Checker 

• Converting a document into an Audio file[8]  

 

A summary of recommended approaches for the accessibility features is provided. 

These recommendations are based on Universal Design for Learning (UDL) and 

Technical Writing Guidelines. However, it should be noted that there are a variety of 

factors that may need to be taken into consideration and balanced when adopting a 

particular approach. It may also be necessary to be cognisant of the type of 
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documentation that is being produced and consider other factors relating to this (e.g. 

marketing documents, formal policies may invariably need to look different). 

 

Depending on the type of document that is being produced, it is acknowledged that 

there may be a number of factors to be considered and a need to balance different 

parameters for a variety of formal University documentation. Therefore, this Guide 

does not outline one set standard for all documentation and recognises that a variety 

of factors may need to be balanced when choosing a document format. The type of 

document being produced may determine which format is selected once all factors are 

considered. 

 

This document is not intended as a Guide for UDL principles in the context of the 

design of learning resources.  

 

3.0  Incorporating Accessibility Features Into Documentation  

This section looks at some of the general design and layout features in MS Word that 

can be selected to improve the accessibility of documentation. These include the font 

style, use of colours and page layout which can be used to assist readers to go through 

resulting documentation, find information easily and understand the document more 

readily. In addition to the general features of Word, there are a number of specific 

useful accessibility features such as text to speech, alternative text (alt text) and the 

accessibility checker, which can assist in enhancing the accessibility of the 

documentation. 

 

Effective practice based on national guidelines from organisations such as AHEAD[9], 

the National Adult Literacy Agency NALA[10] the Center for Applied Special Technology 

CAST[11] as well as EU Directive on accessibility of the website and mobile applications 

of public sector bodies[7] are profiled in  Section 3.1 to Section 3.12.   

 

A summary of recommendations that may be integrated into the development of 

University documentation is provided in Section 3.13. 

 

3.1 Using the Accessibility Checker 

The Accessibility Checker is a feature within Microsoft Office that checks to see how 

accessible a document is and how easy the document is for people with disabilities to 

open, read and edit. When the Checker runs it will highlight any issues within the 

document and provide suggestions on how to resolve them. This feature is a useful 

one to have open from the beginning when writing a document or to look at when a 

https://www.ahead.ie/
https://www.nala.ie/
https://www.cast.org/
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document is being reviewed. 

 

The Accessibility Checker will review the document and highlight issues and warning 

related to poor accessibility. Some of the areas identified in the Accessibility Checker 

include: 

• Any text where there is poor contrast between the background colour and the text.  

• If images or charts are not correctly described or if alternative text is missing from 

an image.  

• Review any tables that have been added to a document and also identify if the 

order and flow of the table is in sequence. 

 

For further details on how to open and use the Accessibility Checker in Microsoft Word 

see Appendix 2. Please note that the Accessibility Checker is available in a range of 

Microsoft Office Applications such as One Note and PowerPoint, inter alia.  

 

3.2  Using Headings Appropriately 

Appropriate use of Headings makes documentation easier to read and helps provide 

a clear structure. Microsoft Word provides a variety of heading styles that can be used 

to automatically generate a Table of Contents.  

 

Using separate Headings and sub-headings will automatically separate content and 

allow readers to find relevant information with greater ease. It will also make 

information easier to scan and will assist anyone using assistive technologies like the 

screen reader.  

• Headings should be different in colour or size and spacing to normal text so 

they are easily identifiable as headings.  

• Use adequate line spacing around a Heading to help distinguish it from normal 

text and to ensure it is not clutter on the page. 

• Use the Headings in the Styles section of the MS Word Ribbon to ensure that 

each Heading style is the same throughout the document. 

 

Figure 1. MS Word Ribbon - Heading Styles 

 

3.3  Typeface and Font   

The typeface and font refer to the style of lettering that is used in the document. The 
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typeface and font selected in a document will impact on the readability of the document 

and readers will likely lose interest or get frustrated if the words are difficult to 

recognise. 

 

Typeface 

Typeface refers to a collection of related fonts, and they are classified by their 

letterforms. Typeface classifications include, Serif, Sans Serif, Script, Monospace 

Display and Handwritten inter alia. 

• San Serif Typeface like Arial, Tahoma and Verdana are considered more 

legible to read on-screen and most suitable for documentation being read on a 

computer. 

• In contrast, other fonts like Bodoni MT poster, chiller and Forte are quite difficult to read and 

may cause difficulty for certain readers. 

 

Font 

Font refers to the style and variation that can be applied to a Typeface. Examples of 

changing a Font include changing the weighting, making the font bold or putting in 

italics.  

 

For example, the Typeface Verdana is used below but a different font is used.  

• Verdana Regular font 

• Verdana Italic font  

• Verdana Bold font  

• Verdana Pro Light 

• Verdana Semi-bold 

 

A document could have one main Typeface throughout the document such as Arial 

with three fonts used to highlight different sections or content within the document 

such as: 

• Arial Regular for standard text 

• Arial Bold for Headings 

• Arial Italics for quotes 

 

3.4  Line Spacing 

Line spacing is the amount of space between each line within a paragraph. Too much 

can make text disjointed and difficult to read and too little can decrease readability. It 

is important to ensure that same line spacing is applied throughout the entire 
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document to make it easier to read.  

• The recommended amount of spacing between lines is 1.2 to 1.5.  

 

3.5  Utilising Bullet points 

Bullet points are an effective way of clarifying and presenting data. They can help to 

focus the reader’s attention and provide a visual break from reading longer sections 

of text. They can be used to highlight the main or key points in a document. 

• Avoid long lists of bullet points and sub divide the points if necessary 

• Avoid italics and underline for emphasis 

• Avoid all CAPS because it may convey the wrong tone and make the text more 

difficult to read. We recognise the word by the shape. This is called Sight 

Vocabulary, and it may slow down the reading process.  

• Use Tab button instead of repeatedly using the spacebar. This creates a better 

experience for students using the “Read Aloud” feature (Read Aloud is a built-

in feature in MS Word that will read aloud any text in a document). 

 

3.6  Colour 

When using colours in documents, ensure that there is strong contrast between the 

text and the background. Poor contrast affects the readers ability to perceive and 

interpret the content.  For text to be legible or for data in diagrams, tables and charts 

to be distinguishable there should be a strong colour contrast. The following are 

examples of good and poor colour contrast: 

- Good contrast between text and background. 

- Poor contrast between text and background.  

Poor contrast can make text very difficult to read. It is advisable to use dark contrasting 

colours like blue, red, green and purple.[8] Certain sight conditions enhance the 

negative effects for bad contrasts and make text even more difficult to read. 

 

3.7  Alternative Text (Alt Text) 

Alternative Text, or Alt Text, provides a description of an image. This text can be used 

to provide an alternative description of the image for those unable to view the image. 

A screen reader can be used to process and read out the description provided.   

 

Screen readers are used to read out text written in a document. However, if there is 

an image, graph or a bar chart then the screen reader cannot process this, and the 

reader will miss out on key information if the Alt Text for the image has not been added. 

• To add Alt Text, right-click image and click “Edit Alt Text” and then enter image 
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description.  

• Enter in a description of the image that can then be read out by the Read Aloud 

Feature in Word.  

 

Figure 2 Illustration of the Alt Text Function 

                                  

3.8  Table of Contents  

A Table of Contents is key to helping people review the contents of a document at a 

high level. It provides an overview of the structure to the document and help readers 

find relevant information quickly and easily. If the Table of Contents feature in MS 

Word is used it will automatically update changes that are made to sections and 

heading within the document. The Table of Contents makes it much easier for learners 

who have a learning difficulty to read and process the information within a document. 

 

Figure 3 Image of the Table of Contents Ribbon 

 

• Any Sections and Headings that are added to a document should be formatted 

using the Styles section outlined in Section 3.2 so they will be recognised and 

included in the Table of Contents. 

• It will automatically edit the Table of Contents based on the Headings that have 

been added to the document.  

• Numbering on Headings and Sections will automatically update if sections are 

manually moved while editing the document. 

 

3.9  Generating Hyperlinks 

When adding hyperlinks into documentation it is important to distinguish the hyperlink 
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from normal regular text, so the reader is aware that a link has been added. The Read 

Aloud feature within MS Word has a shortcut which will bring up a list of the links in a 

document. Links need to be unique and descriptive so that they make sense when 

they are assessed as a list, without the surrounding text for context.  

• Avoid displaying the full URL address on the document page, instead rename 

the link so it is easier for the reader to see what website the link will open.  

• Try and use descriptive and relevant text instead of “click here” or similar 

phrases. 

• The standard format for hyperlinks is underlined text in a blue colour, e.g. TUS 

Midlands Midwest main website would appear as follows:  Home - TUS 

 

3.10  Effectively Displaying Data in Tables, Charts and Diagrams 

Data displays refer to data that is presented in a table, chart or diagram and allows for 

information to be presented in ways that text alone cannot. Diagrams can be used to 

visually display information, they “use visual means to show qualitative differences and 

relationship”[3].  The number and type of charts, diagrams, and tables that can be used 

to represent data will vary for each document.  

The following recommendations will support readers to interpret and follow data being 

displayed: 

• The best way to make sure that charts and diagrams are readable to visually 

impaired learner is to use detailed Alt Text;  

• When adding Alt Text accurately and comprehensively describe every section 

and the connection points of the chart or diagrams;  

• When using line charts, it is important to remember any readers who may be 

colour blind. A slight change in the line style can instantly make the chart more 

accessible e.g. the use of dotted lines instead of different colours; 

• Ensure when using tables and charts that there is good colour contrast between 

the text and the background. 

 

Further details on design recommendations for diagrams and charts are available from 

the following link: Accessibility at Penn State | Charts & Accessibility (psu.edu) 

 

3.11  Forms  

MS Word Forms 

There are many Technological University Forms for both staff and students that are 

developed either as standalone forms or may be included as part of the policy 

document.  

https://tus.ie/
https://accessibility.psu.edu/images/charts/
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When creating a Form, the Developer Tab in Microsoft Word allows for tick boxes, 

drop down menus and lists to be created. These are easier for users to complete and 

more accurate when gathering data. The Developer Tab can be added to the Ribbon 

in Word. The steps for adding and using this feature are available in Appendix 2.  

 

Online MS Forms  

For online forms, as part of the MS Office 365 suite, all staff have access to MS Forms. 

This online form allows a link to be sent and shared out to users to gather and collate 

data. It is recommended to minimise the number of open-ended questions where 

possible.  

 

3.12  Converting a Document into an Audio File  

Information can be processed in multiple different ways, and it is important for writers 

to provide a variety of formats of the information. Producing content in a variety of 

formats and resources will make content/information more accessible. Many people 

find that processing information is made easier by listening to it and it is possible to 

convert a word document into an audio file.  

 

For support on converting a word document to an audio file click on the following guide: 

Convert word documents into audio files 

 

3.13  Using the TUS Brand 

The TUS brand symbolises the University’s identity, heritage, and uniqueness and has 

been of considerable importance to successfully establishing a TUS identity since 

designation. Where relevant the TUS Brand may be incorporated into documentation  

and TUS has provided staff with branding resources (available at https://tus.ie/brand/) 

and the TUS Brand Guidelines that may be of assistance. 

 
3.14 Summary and Overall Recommendations (Accessibility Table) 

A summary that may be used as a quick reference guide when writing University 

Documentation has been collated in Table 1.  

 

  

https://ally.ac/covid19/
https://tus.ie/brand/
https://tus.ie/app/uploads/Marketing/TUSBrand/TUS_Brand-Guidelines_Version-2-1_V3.pdf
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Table 2. Suggested Accessibility Guidelines for Writing Documents* 

Items Description Benefit 

Typeface San Serif such Verdana and 

Arial & Tahoma  

Easier text to read than Serif 

text such as Times New Roman 

Font Keep to the regular font. 

Bold should be reserved for 

Headings or when 

emphasising key words. 

Italics kept to a minimum 

such as quotes. 

Readers with visual 

impairments can see text easier 

in the regular font. 

Easier reading improves 

engagement 

Font Size 

 

MS Word documents – font 

size 12 

Improves readability for readers 

with learning difficulties, low 

visibility students 

Colours 

 

Use of contrasting colours - 

Colours that may not be 

visible to colourblind students 

would include light blue and 

yellow 

Increases engagement and 

easily highlights key information  

Line Spacing 

 

Minimum spacing between 

1.2 and 1.5 

Makes text easier to read  

Section Headings 

 

Clearly identify headings and 

section content  

Allows readers to find relevant 

content easier. 

Page Numbering 

 

Apply number in clear black 

at bottom of page in the 

centre of the page. Avoid the 

use of Roman numerals. 

Page number helps readers 

keep track of the document. 

Table of Contents 

 

Allows for section headings 

to be easily linked to and 

sections and page numbers 

automatically updated. 

Allows readers to view content 

easily and navigate through a 

document 

Graphs  

 

Use graphs with clear data 

Avoid cluttered graphs/charts  

Allows readers to interpret the 

data clearly. 
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Items Description Benefit 

Images and 

Logos 

Including alt text Visually impaired readers can 

use read aloud function. 

Hyperlinks Links are blue and 

underlined 

Provides a consistent and 

standardised format for 

hyperlinks 

Words per 

sentence  

Try to keep sentences 

between 15-20 words. 

Increase accuracy, relevance & 

understanding  

TUS Logo https://tus.ie/brand/ 
 
TUS Brand Guidelines  

 

Incorporating TUS brand 

symbolises the University’s 

identity, heritage, and 

uniqueness. 

 

* Based on guidelines from  AHEAD[3], the National Adult Literacy Agency  NALA[4] and the Center 

for Applied Special Technology CAST[5]. 

Although there are many variances in the type of information that will be included in 

the different types of documentation being produced such as policies, reports, 

application forms, inter alia, the aim is that these guidelines will support consistency 

in the layout, structure and format for how Technological University documentation is 

developed and accessed. 

 

A template file has been created which has been formatted based on the guidelines 

below and is available to download and use from this link: TUS Document Template.  

 

 

  

https://tus.ie/brand/
https://tus.ie/app/uploads/Marketing/TUSBrand/TUS_Brand-Guidelines_Version-2-1_V3.pdf
https://www.ahead.ie/
https://www.nala.ie/
https://www.cast.org/
https://tusmm-my.sharepoint.com/:w:/g/personal/brendan_murphy_tus_ie/EVmEChFS3_9GnSFk3qlkZHIB79opq7LnlxhkWDXHI5X-2A?e=d55XKX
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Appendix 1: Accessibility Checker 

Appendix 2: MS Word Forms 
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Appendix 1: Accessibility Checker 

To access the Accessibility Checker in Microsoft Word, select the Review tab from the 

application Ribbon (Fig.4) 

 

Figure 4 Review Tab in Microsoft Word 

Next select the Check Accessibility menu option (Fig.5) 

 

Figure 5 Accessibility Checker Menu Option 

 

The Accessibility Checker window (Fig 6.) will open on the right-hand side of the Word 

application. Any errors, warnings and suggestions for improving the accessibility of the 

document will be listed in this window. 

 

Figure 6 Accessibility Checker Report 
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Appendix 2: Microsoft Word Forms 

To enable the forms feature in Microsoft Word you need to customise the Ribbon in 

the Word application (Fig. 7). To do this, right click on the Ribbon bar and select the 

Customize the Ribbon option. 

  

 

Figure 7 Customise Ribbon in MS Word 

 

Select Developer from the menu options and then click the OK button. (Fig. 8) 

 

 

Figure 8 Microsoft Word Customise Ribbon Options 
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The Developer tab will now be available along the main Ribbon in the Word application 

(Fig. 9) 

 

 

Figure 9 Developer Tab in MS Word 

When you select this tab, you can access the different questions for designing and 

building a form. The Developer tab allows you to insert a series of question types 

including: 

• Check box,  

• Combo box,  

• Drop down list  

• Date picker  

 

The Restrict Editing options ensure the document format and layout cannot be 

formatted by the end user. For additional support on learning how to use the Developer 

tab please watch the following Video on Creating Forms in Microsoft Word. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.youtube.com/watch?v=mRTQxVauzr0

